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Intermediate Toolbar 
 
The default setting for the Workspace toolbar is the Intermediate toolbar shown below. There 
are also basic, advanced, and customized toolbars. 
 
 

 

Minimize Toolbar 

Mouse Mode 

Selection Tool 

 Highlighter 

Shape Tool 

Type Text Tool 

Clear 

Grid Page 

Previous Page 

Page Sorter 

Toolbox 

Exit  
 

Workspace menu 

Lesson Mode 

Pen Tool 

Eraser Tool 

Line Tool 

Undo 

Blank Workspace Page 

Gallery 

Next Page 

Save 

Student Response System 
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Intermediate Tools and Functions
 

 

  Blank Page 
Create a blank Workspace page.

  Grid Page 
Create a lined 

 

 

  Pen 

Write or make notes on your screen or blank Workspace page. 
Change the pen’s color, thickness, or shape by using the 
Properties Bar

  Highlighter 
Works like an actual highlighter. Adjust 
transparency of the highlighte

  Shapes 
Create a variety of shapes. Modif
color, and transparency 

  Line 
The line tool allows you to draw straight lines. Change the line’s 
thickness, endpoints, and line style by using the 

  Text 

Places a text box
Use the toolbar in the text box to change the font a
split the sentence into words.

 

 

  Selection 
Select, move, or modify the annotations or other objects on 
Workspace pages.

  Eraser 
Erase part of an annotation
using the 

  Undo 
Undo your previous actions.

  Clear 

Clear all annotations off a Workspace page
to the background by the Move to Background tool
locked.

 
 

 

  Gallery 
Insert content 
o
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Tools and Functions 

Page Tools 

Create a blank Workspace page. 

Create a lined or grid Workspace page. 

Annotation Tools 

Write or make notes on your screen or blank Workspace page. 
Change the pen’s color, thickness, or shape by using the 
Properties Bar. 

Works like an actual highlighter. Adjust the shape and 
transparency of the highlighter by using the Properties Bar

Create a variety of shapes. Modify the line color, line 
color, and transparency by using the Properties Bar

The line tool allows you to draw straight lines. Change the line’s 
thickness, endpoints, and line style by using the 

Places a text box on the Workspace page so you can 
Use the toolbar in the text box to change the font a
split the sentence into words. 

Editing Tools 

Select, move, or modify the annotations or other objects on 
Workspace pages. 

Erase part of an annotation. Change the size of the eraser 
using the Properties Bar. 

Undo your previous actions. 

Clear all annotations off a Workspace page, unless they are sent 
to the background by the Move to Background tool
locked. 

Multimedia Tools 

Insert content on your document from the Gallery
organized by subject area. 
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Write or make notes on your screen or blank Workspace page. 
Change the pen’s color, thickness, or shape by using the 

the shape and 
Properties Bar. 

y the line color, line style, fill 
Properties Bar. 

The line tool allows you to draw straight lines. Change the line’s 
thickness, endpoints, and line style by using the Properties Bar. 

Workspace page so you can type text. 
Use the toolbar in the text box to change the font attributes or 

Select, move, or modify the annotations or other objects on 

. Change the size of the eraser by 

unless they are sent 
to the background by the Move to Background tool or if they’re 

Gallery which is 
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Minimize Toolbar 

  Mouse Mode 

  Student Response 
System Functions 

 

 

Workspace Menu 

Page Sorter 

Navigation Arrows 

Save 

Toolbox 

Exit 
 

 Tool Properties 
 

The Properties Bar at the bottom of the Workspace page changes with 
selected from the toolbar. 
 
 

Pen  
 

 
 
 
 
 
 
 

 Line 
Colors 

 

Line
Transparency

Line 
Width 

Color  
Palette 

_________________________________________ Workspace Level 1 Training Workbook

 

Presentation Tools 
 

Minimize your Workspace toolbar so it does not block other 
applications. 

Go to the active desktop or software application to
Workspace tools with other resources. 

 
Create or ask a CPS, Response, or PRS question.

File Management Tools 

Access the File, Edit, Tools, Preferences, and Help menus.

View thumbnails of all Workspace pages to select, rearrange, or 
delete unwanted pages. 

Navigate to different Workspace pages. 

Save a Workspace document. 

Access tools and options not available on the toolbar.

Close the Workspace application. 

The Properties Bar at the bottom of the Workspace page changes with many of the 

Line 
Transparency 

Line  
Ends 

Preview Window 

Dash 
Styles 
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Minimize your Workspace toolbar so it does not block other 

top or software application to use the 

CPS, Response, or PRS question. 

the File, Edit, Tools, Preferences, and Help menus. 

View thumbnails of all Workspace pages to select, rearrange, or 

not available on the toolbar. 

many of the tools 
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Highlighter  
 
 
 
 

 
 
 

Shapes Tool   
 
The Shapes tool allows you to create a
shapes and change many of the shape’s attributes 
such as the line color, line thickness
color, and transparency. 

 
1. Select the Shapes tool. 

 
2. Select your desired attributes from the 

Properties Bar for that shape.
 

3. Click and drag to create the shape on the 
Workspace page or open application.
 

4. Note: Shapes can be rotated by selecting the 
shape and then using the rotator icon at the 
top of the selected shape to click and drag.

 

 Line Tool  
 
The line tool allows you to draw straight lines.
endpoints, and line style by using the Properties Bar.
 

1. Select the Line tool. 
 

2. Select your desired attributes from the 
 

 

 
 

3.  Click and drag to create the 
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Line 

Options 

 

The Shapes tool allows you to create a variety of 
and change many of the shape’s attributes 

thickness, line style, fill 

 

Select your desired attributes from the 
for that shape. 

to create the shape on the 
Workspace page or open application. 

Shapes can be rotated by selecting the 
shape and then using the rotator icon at the 
top of the selected shape to click and drag. 

The line tool allows you to draw straight lines. You can also change the line thickness, 
and line style by using the Properties Bar. 

Select your desired attributes from the Properties Bar. 

to create the line on the Workspace page. 

Highlighter 
Colors 

Color  
Palette 

Highlighter 
Shape 

 
Transparency 

Line 
Width 
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Fill 

Options 

You can also change the line thickness, 
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Text  
 

1. Select the Text tool. 
 

2. Click on the Workspace page to produce a text box. 
 

3. Use your keyboard or on-screen keyboard to type text. 
 

4. Select the text and change any font attributes desired using the toolbar in the text 
box. 
 

5. Note: To change or modify text, use the selection tool to double click on the text. 
 

 
 
 

 
 
 

 
 
 
 
 
 
 
Layers 

Layers provide a way to manage all the items that make up your Workspace page. Layers can 
be considered clear folders that contain annotations. If you reshuffle the folders, you change 
the stacking order of the items in your annotations.  

The structure of layers in your Workspace page can be as simple or complex as you want it to 
be. By default, all items are organized in a single, parent layer. However, you can create new 
layers and move items into them, or move elements from one layer to another at any time.  

You use the Layers function to list, organize, and edit the objects in a document. By default, 
every new page contains one layer, and each object you create is listed under that layer. 
However, you can create new layers and rearrange items to best suit your needs.  

To add layers to your Workspace document: 
 

1. Locate the Layer Toolbar at the bottom left corner of the 
Workspace document. 

2. Click the Add Layer button  to add a layer on top of your Workspace document. 
 

3. You will then see the Layer Toolbar maximized with additional options: 

Split Sentence 
into Words 

Clone 
Text Formatting Options 
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Interactive Modes 
 

The Interactive Mode has two functional modes, 
 

Mouse Mode   
 

The Mouse Mode tool allows you to leave 
desktop or open software application.
 

When you use the tools, Workspace grabs a screen capture of whatever you have open on your 
computer and brings it in as a Workspace page automatically.
you to use all of the Workspace tools to add interactivity and annotation features to your 
presentation. 
 

To return to your Workspace document you ca
page sorter tool. The Mouse Mode 
are in Mouse Mode. 

Annotate Over Desktop Mode
 

The Annotate Over Desktop Mode tool
to your active desktop or open software 
 

When you use the Workspace tools, you stay in the current application so all of the features of 
that application are still live (scroll bar, links, etc.).
all of the Workspace tools to add interactivity and annotation features to your presentation 
without going back to the Workspace environment.
 

To return to your Workspace document you ca
Mouse Mode tool. You will be prompted to save the annotations made to the live document. If 
you click yes, a Workspace page will be created to save the annotations. If you click no, you 
cannot recapture your annotations.
 
 

Move Layers Up or Down 

_________________________________________ Workspace Level 1 Training Workbook

 

has two functional modes, Mouse Mode and Annotation Mode

allows you to leave a Workspace page and return back to your active 
application.  

When you use the tools, Workspace grabs a screen capture of whatever you have open on your 
Workspace page automatically. This seamless integration allows 

you to use all of the Workspace tools to add interactivity and annotation features to your 

To return to your Workspace document you can either use the Previous/Next Page tool or 
The Mouse Mode tool will be grayed out on the Workspace toolbar 

Annotate Over Desktop Mode   

Mode tool allows you to leave a Workspace page and return back 
open software application.  

When you use the Workspace tools, you stay in the current application so all of the features of 
that application are still live (scroll bar, links, etc.). This seamless integration allows you to use 
all of the Workspace tools to add interactivity and annotation features to your presentation 
without going back to the Workspace environment. 

To return to your Workspace document you can either use the Previous/Next Page tool
You will be prompted to save the annotations made to the live document. If 

you click yes, a Workspace page will be created to save the annotations. If you click no, you 
cannot recapture your annotations. 

Select Layers

Show/Hide Layers

Edit Selected Layer 
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Mode. 

Workspace page and return back to your active 

When you use the tools, Workspace grabs a screen capture of whatever you have open on your 
This seamless integration allows 

you to use all of the Workspace tools to add interactivity and annotation features to your 

age tool or the 
on the Workspace toolbar when you 

Workspace page and return back 

When you use the Workspace tools, you stay in the current application so all of the features of 
integration allows you to use 

all of the Workspace tools to add interactivity and annotation features to your presentation 

age tool or the 
You will be prompted to save the annotations made to the live document. If 

you click yes, a Workspace page will be created to save the annotations. If you click no, you 

Select Layers 

Show/Hide Layers 
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Module 2:  

Creating Interactive Content 
 

 
 
 

Overview 
 
This session is designed for the beginner who has only connected the Interwrite Board or Pad 
to the computer, launched the software, and made a basic Workspace document. The 
Interactive mode of the software with the advanced toolbar will be used in this session. 
Participants will learn how to create and save a basic Workspace lesson that incorporates a 
variety of pages, text, drawings, and images.  
 
 

Objectives 
 
After completing this module, participants will be able to: 
 

• Access tools from the advanced toolbar 

• Use math tools to measure angles, lines, and other objects 

• Create and modify page types to meet instructional needs 

• Use editing tools 

• Use content from the Gallery 

• Manage a Workspace file 
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Advanced Toolbar 
 
The advanced toolbar will give you easy access to a variety of tools that are normally available 
in the toolbox. For the activities in this module you will need to change to the advanced toolbar.  
 

1. Click on the Menu button and choose Preferences. 
 

2. Click on the Customize Toolbar option. 
 

3. Choose Advanced from the drop down menu. 
 

4. Click OK. 
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Advanced Toolbar 
 

 

Minimize Toolbar 

Mouse Mode 

Annotate Over Desktop 

Selection Tool 

Multicolor Pen 

Freehand Text 

Highlighter 

Line Tool 

Fill  

Text 

Clear 

Curtain 

Record and Playback 

Ruler 

Triangle 

Create Grid Page 

Previous Page 

Page Sorter 

Toolbox 

Exit 

Workspace Menu 

Lesson Mode 

Office Mode 

Pen Tool 

Freehand Shape 

Picture Pen 

Shapes 

Stamper 

Eraser 

Undo 

Gallery 

Capture 

Compass 

Protractor 

Create Blank Page 

New Page Setup 

Next Page 

Save 

Student Response System 



________________________________

 

Advanced Tools and Functions
 

 

  New Page Setup 
Modify the properties 
gr

 

  Freehand Text 

Instantly c
(
to your computer.

  Freehand Shape 

Any shapes drawn with the Freehand Shape tool will be 
automatically converted to one of several common shapes
triangle, rectan
available 
computer.

  Multicolor Pen 
Write with a rainbow or two
colors by using the Pro

  Picture Pen 

Draws a series of pictures from eight available styles. 
the picture or change the picture and size by using the 
Properties Bar

  Stamper 
Stamp a single small picture on your page
styles. 

  Fill 
F

 

 

  Capture 
S
screen or a Workspace page.

  Record and Playback 
Create a video capturing your voice 
any an

 

 

  Curtain 
The 
what you don’t want participant

 
Annotate Over  
Desktop 

Make annotations on a live document. Determine when you are 
done if you want 
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Tools and Functions 

Page Tools 

Modify the properties for the following page types: 
gradient, and calendar. Access image pages. 

Annotation Tools 
 

Instantly converts handwritten words to typed text.
(Note: Only available with an Interwrite Board or Pad connected 
to your computer.) 

Any shapes drawn with the Freehand Shape tool will be 
automatically converted to one of several common shapes
triangle, rectangle, square, circle and ellipse. (Note:
available with an Interwrite Board or Pad connected to your 
computer.) 

Write with a rainbow or two-tone color pattern. 
colors by using the Properties Bar. 

Draws a series of pictures from eight available styles. 
the picture or change the picture and size by using the 
Properties Bar. 

Stamp a single small picture on your page from 
styles. Customize the picture by using the Properties Bar

Fill a shape, page background, and images with color.

Multimedia Tools 

Selectively capture a portion of another software application’s 
screen or a Workspace page. 

Create a video capturing your voice (microphone needed
any annotations being made on your computer. 

Presentation Tools 

The curtain is resizable, movable, and transparent 
what you don’t want participants to see. 

Make annotations on a live document. Determine when you are 
done if you want to save the annotations before moving on.
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for the following page types: blank, grid, 

words to typed text. 
Interwrite Board or Pad connected 

Any shapes drawn with the Freehand Shape tool will be 
automatically converted to one of several common shapes: 

Note: Only 
Interwrite Board or Pad connected to your 

tone color pattern. Change the pen 

Draws a series of pictures from eight available styles. Customize 
the picture or change the picture and size by using the 

from 15 available 
Customize the picture by using the Properties Bar. 

images with color. 

electively capture a portion of another software application’s 

microphone needed) and 
 

is resizable, movable, and transparent to “hide” 

Make annotations on a live document. Determine when you are 
to save the annotations before moving on. 
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  Office Mode 

 
Allows you to integrate Workspace lessons and Microsoft Office

 

 

      Compass 

The 
arcs, and measure distances within the 

  Ruler 
The r
between two points within the Annotation Window.

  Protractor 

The Protractor allows you to demonstrate how to use angle 
measurement within the Annotation Window. The 
displays the angle in degrees within the tool.

   Triangle 

The t
within the Annotation Window.

 

Tool Properties 

The Properties Bar at the bottom of the Workspace page changes with many of 
selected from the toolbar. 
 
 

Freehand Text  
 
Select a different font, change the font size, the font style, and the font color from the 
Properties Bar before you begin writing. Your selections are displayed in the preview window.
 

 
 

Freehand Shape   
 
Select the line color, line size, line endpoints, and line style
begin drawing. Your selections are displayed in the preview window.
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Allows you to integrate Workspace lessons and Microsoft Office

Math Tools 

The compass allows you to demonstrate how to draw circles, 
arcs, and measure distances within the Annotation Window.

The ruler allows you to demonstrate how to use measurement 
between two points within the Annotation Window.

The Protractor allows you to demonstrate how to use angle 
measurement within the Annotation Window. The 
displays the angle in degrees within the tool. 

The triangle tool allows you to demonstrate how to measure 
within the Annotation Window. 

The Properties Bar at the bottom of the Workspace page changes with many of 

Select a different font, change the font size, the font style, and the font color from the 
you begin writing. Your selections are displayed in the preview window.

the line color, line size, line endpoints, and line style from the Properties Bar 
. Your selections are displayed in the preview window. 
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Allows you to integrate Workspace lessons and Microsoft Office 

ompass allows you to demonstrate how to draw circles, 
Annotation Window. 

uler allows you to demonstrate how to use measurement 
between two points within the Annotation Window. 

The Protractor allows you to demonstrate how to use angle 
measurement within the Annotation Window. The Protractor 

riangle tool allows you to demonstrate how to measure 

The Properties Bar at the bottom of the Workspace page changes with many of the tools 

Select a different font, change the font size, the font style, and the font color from the 
you begin writing. Your selections are displayed in the preview window. 

 

from the Properties Bar before you 
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Multicolor Pen  
 

• When the Gradient Style
to the left of the Gradient Style button define the starting color, while the properties to 
the right define the ending color. 
 

• When the Color on Color Style
properties to the left of the Gradient Style button define the outside, border color, while 
the properties to the right define the inside color.

 

 

Picture Pen  
 

• The currently selected picture is displayed on the left side of the 
it to access a menu of picture
 

• Click on the line width property to 
 

• Click on the Add Picture
the location on your computer where the picture is stored. 
the currently selected picture on the picture menu. 
GIF, JPEG, TIFF, or PNG 

 

• You can also change the background color
 

 

Stamper  
 

• The pre-installed stamp selections are displayed on the Stamper
 

• Click on the Add Picture
the location on your computer where the picture is stored. (
BMP, GIF, JPEG, TIFF, or PNG
 

• If you add new stamp images to the User Stamps folder while Workspace is running, the 
stamps will not be available for use until you exit Workspace and re
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Gradient Style is selected, the color, line width and transparency properties 
to the left of the Gradient Style button define the starting color, while the properties to 
the right define the ending color.  

Color on Color Style is selected, the color, line width and transparency 
properties to the left of the Gradient Style button define the outside, border color, while 
the properties to the right define the inside color. 

The currently selected picture is displayed on the left side of the Properties Bar. Click on 
it to access a menu of pictures. 

Click on the line width property to select a size for the images on the path.

Picture button to add a new picture to the picture menu.
on your computer where the picture is stored. The new picture will replace 

the currently selected picture on the picture menu. (Note: Images must be in a BMP, 
 format.) 

change the background color of the selected picture. 

 

installed stamp selections are displayed on the Stamper Properties Bar.

Picture button to add a new picture to the picture menu.
on your computer where the picture is stored. (Note: Images must be in a 

BMP, GIF, JPEG, TIFF, or PNG format.) 

If you add new stamp images to the User Stamps folder while Workspace is running, the 
stamps will not be available for use until you exit Workspace and re-open it.
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is selected, the color, line width and transparency properties 
to the left of the Gradient Style button define the starting color, while the properties to 

h and transparency 
properties to the left of the Gradient Style button define the outside, border color, while 

 

Properties Bar. Click on 

on the path. 

add a new picture to the picture menu. Navigate to 
The new picture will replace 
mages must be in a BMP, 

Properties Bar. 

add a new picture to the picture menu. Navigate to 
mages must be in a 

If you add new stamp images to the User Stamps folder while Workspace is running, the 
open it. 
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Fill   
 

• Choose the color desired from the Properties Bar.
 

• Click on the location you want the color to be added to fill it in.
 

 

Math Tools 
 

Compass  
 
You can move, size, and rotate the Compass. The Compass resizes itself to scale within the 
Annotation window. The Colored tip 
Clear Tip remains stationary so the arc or the circle can be drawn.
 
To change the radius of the compass, move your cursor to the colored tip until the Compass 
displays the arrow. You can then drag 
 

1. Click the Compass icon. 
 

2. Click the top of the Compass to move it around the Annotation Window.
 

3. To change the color of the pen tip, select from the Workspace palette at the 
the Annotation Window. 
 

  
4. Click the Compass icon to close the Compass and remove it from the Annotation 

Window. 
 
 
Draw an Arc with the Compass

1. Move your cursor to the colored tip until the Compass displays the arrow. 
 

2. Click and drag the tip to the desired area.
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desired from the Properties Bar. 

Click on the location you want the color to be added to fill it in. 

You can move, size, and rotate the Compass. The Compass resizes itself to scale within the 
Annotation window. The Colored tip draws the circle or arc within the Annotation Window. The 
Clear Tip remains stationary so the arc or the circle can be drawn. 

To change the radius of the compass, move your cursor to the colored tip until the Compass 
displays the arrow. You can then drag that end to the desired radius. 

 The Compass opens within the Annotation Window.

Click the top of the Compass to move it around the Annotation Window.

To change the color of the pen tip, select from the Workspace palette at the 
 

icon to close the Compass and remove it from the Annotation 

an Arc with the Compass 

Move your cursor to the colored tip until the Compass displays the arrow. 

to the desired area. The tip changes back to the draw cursor. 
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You can move, size, and rotate the Compass. The Compass resizes itself to scale within the 
draws the circle or arc within the Annotation Window. The 

To change the radius of the compass, move your cursor to the colored tip until the Compass 

The Compass opens within the Annotation Window. 

Click the top of the Compass to move it around the Annotation Window. 

To change the color of the pen tip, select from the Workspace palette at the bottom of 

 

icon to close the Compass and remove it from the Annotation 

Move your cursor to the colored tip until the Compass displays the arrow.  

The tip changes back to the draw cursor. 
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3. Move the cursor to draw the arc. Workspace displays the arc 
within the Annotation Window. 

 

 

 

 

 

Ruler   
 
You can move, size, and rotate the ruler. The ruler resizes itself to scale within the Annotation 
window.  The ruler can toggle between meter stick ruler options of 20 centimeters and 1 meter, 
and can rotate the via any corner. 
 

1. Click the Ruler icon.  The Ruler opens in the Annotation window. 
 

2. Move the red bars to measure an object within the Annotation Window. 
There are two bars on the ruler. 
 

3. Rotate the ruler to another angle.   
 

4. Show the angle of the ruler after it is rotated.   
 

5. Move the ruler to any place within the Annotation Window.   
 

6. Resize the ruler within the Annotation Window.   
 

7. Click the Ruler icon to close the ruler and remove it from the Annotation Window. 
 

NOTE: The Ruler will also allow you to draw straight lines along the edge using the Pen Tool. 
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Protractor  
 
You can move, size, and rotate the protractor. The protractor resizes itself to scale within the 
Annotation window. 
 

1. Click the Protractor icon.  
 

2. Select 180 Degree or 360 Degree. The selected Protractor opens within the Annotation 
Window. 
 

3. Move the red bars to measure the angles of an object within the Annotation Window. 

There are two bars on the Protractor.   
 

4. Select the Protractor. The Rotate cursor displays at the top when the cursor is moved to 

the top of the Protractor. Rotate the Protractor to another angle.   
 

5. Show the angle and radian of the Protractor after the measurement bars have been 

moved to the correct angle.   
 

6. Move the Protractor to any place within the Annotation Window.   
 

7. Resize the Protractor within the Annotation Window.   
 

8. Click the Protractor icon to close the Protractor and remove it from the Annotation 
Window. 
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Triangle  
 
You can move, size, and rotate the Triangle. The Triangle resizes itself to scale within the 
Annotation window.  
 

1. Click the Triangle icon.  
 

2. Select Left Facing or Right Facing. The selected Triangle opens within the Annotation 
Window. 

 

3. Rotate the Triangle to another angle.   
 

4.  Move the red bars to measure an object within the Annotation Window. There are two 

bars on the triangle.   
 

5. Displays the angle between the two bars and the length of the tool. 

 
 

6. Move the ruler to any place within the Annotation Window.   
 

7. Resize the ruler within the Annotation Window.   
 

8. Click the Triangle icon to close the Triangle and remove it from the Annotation Window. 
 
  

  
NOTE: The Triangle can toggle toggle between meter stick ruler options of 20 centimeters and 
1 meter, and can rotate by any corner.
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Create and Modify Pages
 
Blank pages are only one option with Workspace.
pages, gradient pages, and even page transitions
 

The New Page Setup tool 
and customize pages.  
 

 
 
 
 
 
 
Grid Page Tool  
 
This tool allows you to create a lined page. The page can have vertical lines, 
both. You can also customize your grid pages.

 
1. Click on the New Page Setup 

 
2. Select your desired options.

 
3. To change or create a new 

desired option. 
 

4. Click OK. 
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Pages 

Blank pages are only one option with Workspace. You can also create grid pages, calendar 
, and even page transitions to meet your instructional needs.

  will allow you to access, create, 

 

This tool allows you to create a lined page. The page can have vertical lines, horizontal lines
both. You can also customize your grid pages. 

ge Setup tool and select Grid Page Setup. 

Select your desired options. 

To change or create a new Grid Page from this screen, click on Apply, then select your 
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grid pages, calendar 
to meet your instructional needs. 

horizontal lines, or 

, then select your 



_________________________________________ Workspace Level 1 Training Workbook 

  31 

 
Gradient Page  
 
The gradient page allows you to create a colorful page that can grab students’ attention. 
 

1. Click on the New Page Setup tool and select Gradient Page Setup. 
 

2. Select your desired options. 
 

3. To change or create a new Gradient Page from this screen, click on Apply, then select 
your desired option. 

 
4. Click OK. 
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Calendar Page  
 
This will create a background page that looks like a calendar. You can choose to display one 
week, or one to four months, on a single page. 

 
1. Click on the New Page Setup tool and select Create Calendar Page. 

 
2. Select your desired options. 

 
3. Click OK. 

 

 
 
Page Transitions 

Slide transitions are the animation-like effects that occur when you move from one page to the 
next during an on-screen presentation. You can control the speed of each slide transition effect. 
There are more than 40 transitions from which to select. 

Creating Transitions in a Workspace Document 

1. While in Lesson Mode, open a page. 
2. Make sure Page Properties are displayed at the bottom of the page. 

3. Click Page Transitions.  
The Page Transitions Properties window opens. 
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4. Select the transition you want from the Effect drop-down list.  
 
As you select each transition, an example of the transition displays in the window. 

5. Select the speed needed for the transition in the Speed drop-down list. 
6. Select Apply to All if you want the same transition for all pages. 
7. Click OK. 

 
The transition is applied to the page. 

Record and Playback 
 
The Record and Playback tool allows you to record your voice (if you have a microphone on 
your computer) as well as your annotations or programs you have running on your screen. It’s 
a great tool to make your own tutorials for students. 

1. Go to the toolbox    and select the Record and Playback  tool. 
 

2. Click on the Record button to start recording.  
 

 
 

3. Use programs on your computer or create notes and diagrams with the Workspace 
software. When you are done, click on the Stop Recording button. 



________________________________

 

 

 
4. Save your file. 

 
Note: The Record and Playback fi
the video file back by pressing the green play
 

Workspace Editing Tools
 

Access these tools by using the Selection 
will appear in the Properties Bar at the bottom of the screen.
 

 
 

 

 Undo/Redo 

Undo 
continue until you have undone the first thing 
last thing 

  Cut 
Remove or “cut” a selected entity.

  Copy 
Make a copy of a selected entity.

  Paste 
Place a

  Select all 
Select all entities on a Workspace page.

  Order Selected Entities 
Select the position of 
back of 

 
Rotate Selected 
Entities 

Rotate 
vertically.
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The Record and Playback files save as an .avi file. Once your file is saved,
k by pressing the green play button.  

Workspace Editing Tools 

ccess these tools by using the Selection  tool to choose an annotation. The editing options 
will appear in the Properties Bar at the bottom of the screen. 

Editing Tools 

Undo and redo the most recently performed operation
continue until you have undone the first thing or redo until the 
last thing you did is on the page. 

Remove or “cut” a selected entity. 

Make a copy of a selected entity. 

Place an entity that was cut or copied on the Workspace page.

Select all entities on a Workspace page. 

Select the position of an entity. Send the entity in front or 
back of a different entity to create layers. 

Rotate entities 90°, 180°, or flip the entity horizontally or 
vertically. 
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, you can play 

to choose an annotation. The editing options 

 

operations. You can 
or redo until the 

on the Workspace page. 

entity in front or in 

, or flip the entity horizontally or 



________________________________

 

  Group 
G

  Ungroup 
Ungroup a grouped entity.

  Move to Background 
Permanently “glue” an entity to the background of a
page.

  Export Entities 
Select an entity on the page and convert it into an image file.

 Add files to Gallery 
Add a selected entity or entire page to the gallery.

 

 Gallery Content 
 
This tool allows you to insert content from 
organized by subject area. There are three types of resources available from the Gallery.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gallery at a Glance 
 

Main Category 

Arts and Recreation Art, Games, Music, Sports

Graphic Organizers Venn diagrams, various flow charts, language arts charts, etc.

Interwrite Sims Games, Science, Social Studies, Math, Language Arts, Teacher Tools

ExamView® Add your own 

lesson. Comes with sample content.

Language Arts Handwriting, Grammar, Sight Words, Word Parts (Blends, Prefixes, 

Roots, Word Families, etc.), Literature, Poetry

Math Dice, Dominoes, Geometry, Manipulatives, Money, Numbe

Image Page: This image 
will take up the full 
screen. The flap in the top 
right-hand corner indicates 
this is an image page. 
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Group separate entities together to create one entity.

Ungroup a grouped entity. 

Permanently “glue” an entity to the background of a
page. 

Select an entity on the page and convert it into an image file.

Add a selected entity or entire page to the gallery.

This tool allows you to insert content from the Gallery into your document. The pictures are 
organized by subject area. There are three types of resources available from the Gallery.

Sub-Categories/Descriptions 

Art, Games, Music, Sports 

Venn diagrams, various flow charts, language arts charts, etc.

Games, Science, Social Studies, Math, Language Arts, Teacher Tools

Add your own ExamView content to the Gallery for easy access during a 

lesson. Comes with sample content. 

Handwriting, Grammar, Sight Words, Word Parts (Blends, Prefixes, 

Roots, Word Families, etc.), Literature, Poetry 

Dice, Dominoes, Geometry, Manipulatives, Money, Numbe

Image: This is a single 
image. You can resize 
this image. 

Sims: Many of these 
files have sound 
and/or animations.
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together to create one entity. 

Permanently “glue” an entity to the background of a Workspace 

Select an entity on the page and convert it into an image file. 

Add a selected entity or entire page to the gallery. 

Gallery into your document. The pictures are 
organized by subject area. There are three types of resources available from the Gallery. 

Venn diagrams, various flow charts, language arts charts, etc. 

Games, Science, Social Studies, Math, Language Arts, Teacher Tools 

for easy access during a 

Handwriting, Grammar, Sight Words, Word Parts (Blends, Prefixes, 

Dice, Dominoes, Geometry, Manipulatives, Money, Numbers and 

Many of these 
files have sound 
and/or animations. 
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Symbols, Tools, Math Facts, Equations, Fractions, Algebra, Tables and 

Graphs, Calculus, Various Graph Papers and Grid Backgrounds 

My Gallery Provides a place for you to add and created your own custom Gallery 

Science Anatomy, Animals, Biology, Chemistry, Environment, Food, Geology, 

Physics, Space, Tools, Weather 

Social Studies Geography, Street Signs, Transportation, Emotions, Historical, Everyday 

Things, Holidays 

Special Needs Sign Language 

Lessons Access sample lessons as well as lessons online 

Video Tutorials Links you to our website to access self-paced Workspace tutorials 

 
Add Objects from the Gallery to a Page 
 

1. Click on the Gallery  icon on your toolbar. 
 

2. Browse or use the search feature to locate an image or Sim that you would like to use. 
 

3. Use the Selection  tool  
to drag the image over to  
the Workspace page. 

 
 

Gallery Menu 

Navigation and 
Search 

Content Categories and 
Sub-Categories 
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Manage Your Workspace File 
 
 
Organize a Workspace File  
  

1. Click on the Page Sorter icon from the toolbar. 
2. To delete pages, click on the ones you do not want, 

then click on the recycle bin icon. You can also press 
delete on your keyboard. 

3. To rearrange pages, use the cursor to select one 
page. Next, drag the page somewhere else in the page 
sorter view to reposition. 
 

4. Click on the Menu  icon to view some of the other 
options available with the page sorter. 

5. When you are done, click on the “X” to close the page sorter 
view. 

 
 
 
 Save a Workspace File 
 

1. Use the Page Sorter  to delete and arrange your Workspace pages. 

2. Click on the Save  button from the toolbar. 
3. Close Workspace. 
4. To open your Workspace file, either double click on the file or if you are in Workspace 

click on the Menu>File> Open. 
 
 
 
Export a Workspace File 
 

1. Go to Menu>File> Export. 
2. Choose the format you wish to export, the 

location you would like to export to, and then the 
page(s) you wish to export. 

3. Click Export when you are done.  
 
 
 
Print a Workspace File 
 

1. From the Workspace toolbar, go to Menu>File> Print. 
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Module 3:  

Engaging Content with Learners 
 

 
 
 

Overview 
 
This session is designed for someone who has experience creating a Workspace lesson and 
knowledge of the annotation and presentation tools. Participants will learn how to use various 
tools to engage students and enhance their teaching with a Workspace lesson.  
 
 

Objectives 
 
After completing this module, participants will be able to: 

 

• Identify and use Workspace tools to engage students and content 

• Review various instructional applications of Workspace tools 

 



________________________________

 

Using Workspace to Engage Students
 
Workspace has a variety of tools 
being taught. Many of the tools used to create a lesson can also be used to engage a lesson.
 
Some of the common tools already showcased in modules one and two that 
engage a lesson are Freehand Text
and Stamper. Some new tools showcased 
 
* These tools are located in the toolbox.
 
 
Curtain  
 
The Curtain allows you to “hide” what you don’t want students to see. The Curtain is resizable, 
movable and can be made transparent. 

 
1. Go to a document or page 

2. Click on the Curtain 
will appear in the Properties Bar

3. Use the handles to resize
anywhere on the screen. 

4. When you are done with the Curtain, click on the 
of the screen. 
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Using Workspace to Engage Students 

tools that are designed to increase interactivity with
Many of the tools used to create a lesson can also be used to engage a lesson.

already showcased in modules one and two that can be
Freehand Text, Freehand Shape, Highlighter, Multicolor Pen, 

. Some new tools showcased below are the Curtain, Timer*, and Spotlight*

are located in the toolbox. 

The Curtain allows you to “hide” what you don’t want students to see. The Curtain is resizable, 
movable and can be made transparent.  

Go to a document or page where you want to use the Curtain. 

 icon from your toolbar or toolbox. The Curtain’s properties 
Properties Bar. 

handles to resize your Curtain, or use the cursor to reposition 
 

When you are done with the Curtain, click on the Close Curtain button
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are designed to increase interactivity with the content 
Many of the tools used to create a lesson can also be used to engage a lesson. 

can be used to 
ticolor Pen, Picture Pen, 

Spotlight*. 

The Curtain allows you to “hide” what you don’t want students to see. The Curtain is resizable, 

The Curtain’s properties 

cursor to reposition the Curtain 

Close Curtain button at the bottom 

 

 



________________________________

 

Spotlight  
 
The Spotlight allows you to view a small part of your screen. The Spotlight is similar to the 
Curtain; however, you can change the Spotlight to be a different shape. 
normally housed in the toolbox. 
toolbar. 
 

1. Go to a document or page 

2. Click on the Spotlight 
properties will appear in the 

3. Use the cursor to drag 
4. When you are done with the Spotlight, click on the 

bottom of the screen. 

 
 
Timer 
 
The timer will beep and flash to indicate time is up

1. Click on the Timer 
or toolbox. 

2. Set the timer to either a timer or stopwatch
clicking in the radio button before your choice.

3. Click on the Set Timer drop
the length of time you need

4. Press Start to begin. 

Close
Spotlight

Spotlight 
Options 

Menu 

Resizing 
Handles 

Spotlight Properties
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allows you to view a small part of your screen. The Spotlight is similar to the 
you can change the Spotlight to be a different shape. The spotlight is 

. You can use the Preferences option to add the spotlight to the 

Go to a document or page where you want to use the Spotlight. 

 icon from your toolbar or toolbox. The Spotlight’s 
properties will appear in the Properties Bar. 

 the Spotlight anywhere on the screen. 
When you are done with the Spotlight, click on the Close Spotlight button

The timer will beep and flash to indicate time is up or count time to the second as a stopwatch

 icon from your toolbar 

timer or stopwatch by 
clicking in the radio button before your choice. 

drop-down arrow to select 
need. 

Close 
Spotlight 

Properties 
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allows you to view a small part of your screen. The Spotlight is similar to the 
The spotlight is 

You can use the Preferences option to add the spotlight to the 

The Spotlight’s 

Close Spotlight button at the 

 
 
 

 
 
 
  
 
 
 
 
 
 
 

or count time to the second as a stopwatch. 



________________________________

 

Instructional Applications 
 
Listed below are common tools and instructional applications
of these tools with one of its corresponding instructional applications
 
 

 

Tool 

  Blank Page 

•

•

•

  Grid Page 

•

•

•

•

•

•

•

•

•

•

  Calendar Page   

•

•

•

•

•

•

•

•

•

 
 

 

  Pen 

•

•

  Multicolor Pen 

•

•

•

  Picture Pen 

•

•
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Instructional Applications with Workspace Tools 

below are common tools and instructional applications for each of them. 
of these tools with one of its corresponding instructional applications. 

Page Tools 

Instructional Application 

• Workspace lessons 

• Class or meeting note taking 

• Student portfolios 

• Notebook paper 

• Handwriting exercises 

• Custom graph paper for area, perimeter, picture graphs

• Math arrays 

• 100s chart 

• Mapping activities or scale 

• Reward charts 

• Attendance charts 

• Crossword puzzles 

• Word finds 

• Document assignments 

• Project management 

• Morning calendar activities 

• Birthday chart 

• Math activities involving time 

• Reflection journal 

• Attendance graphing 

• Weather charting 

• Class jobs and responsibilities 

Annotation Tools 

• Writing and drawing 

• Summarizing and note taking 

• Tracing or handwriting practice 

• Use instead of a pen to add a little flair to your lessons

• Customize with school or class colors to build school pride

• Change image based on lesson theme 

• Customize with your subject area 
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 Try using some 

 

ustom graph paper for area, perimeter, picture graphs 

Use instead of a pen to add a little flair to your lessons 

Customize with school or class colors to build school pride 



________________________________

 

  Freehand Text 

•

•

  Text 

•

•

  Highlighter 

•

•

•

  Line 

•

•

•

•

•

•

•

  Shapes 

  Freehand Shape 

•

•

•

•

•

  Stamper 

•

•

•

•

•

•

•

  Fill 

•

•

 
 

 

  Selection 
•

  Eraser 
•

  Copy 

•
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• Label diagrams 

• Writing definitions 

• Use to type labels for a diagram 

• Use with the “Split Sentence into Words” function to create 

Language Arts activities 

• Highlight vocabulary words and important concepts on 

websites, PPT’s, and scanned documents 

• Main idea and supporting details 

• Fact vs. opinion statements 

• Making lines, arrows 

• Connect ideas 

• Make game boards 

• Make custom handwriting paper 

• Labeling  

• Create custom angles/polygons 

• Make tables 

• Make “hide” boxes or flash cards 

• Create graphics  

• Create flow charts 

• Make shapes for sorting activities 

• Make your own tessellations 

• Accent what is on the screen 

• Use in checklists or graph activities 

• Use as reward stickers 

• Use for manipulatives for sorting, patterns, or counting

• Customize with your own pictures to support a thematic unit

• Use in math arrays 

• Graphs 

• Fractions 

• Draw attention to detail of image 

Editing Tools 

• Move objects to reveal answers underneath 

• Erase ink to reveal object underneath 

• Copy and paste multiple objects on top of one another to be 

used in learning activities (i.e. money) 
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Use with the “Split Sentence into Words” function to create 

vocabulary words and important concepts on 

Use for manipulatives for sorting, patterns, or counting 

Customize with your own pictures to support a thematic unit 

 

Copy and paste multiple objects on top of one another to be 



________________________________

 

  Paste 

  Order Selected Entities 

•

•

  Move to Background 

•

 
 

 

  Gallery 

•

•

•

  Record and Playback 

•

•

  Capture 
•

 
 

  Curtain 

•

•

•

  Spotlight  

•

•

  ExamView File 

  Student Response 
System Functions 

•

•
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• Create layers with entities 

• Create flash cards 

• “Glue” items or answers to the page, then cover over the 

items with ink, use the eraser to uncover the answer

Multimedia Tools 

• Interactive simulations 

• Content-related images and diagrams 

• Story telling/retelling 

• Record lessons for absent students to review content

• Create video tutorials 

• Capture images from a Web site or your computer

Presentation Tools 
 

• Use with text to help with reading/tracking 

• Reveal parts of a presentation, website or reading selection

• Prediction activities “Guess what is behind the curtain based 

on these clues?” 

• Prediction activities 

• Focus on parts of a diagram or text 

• Check for understanding by inserting questions from 

ExamView tests and question banks 

• Get immediate feedback to questions 
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lue” items or answers to the page, then cover over the 

items with ink, use the eraser to uncover the answer 

Record lessons for absent students to review content 

Capture images from a Web site or your computer 

bsite or reading selection 

Prediction activities “Guess what is behind the curtain based 

uestions from 
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Module 4:  

Integrating Multimedia Resources 
 

 
 
 

Overview 
 
This session is designed for someone who has experience using the Workspace tools. 
Participants will learn how to link from a Workspace page to other resources and add 
multimedia to a Workspace page. They will also learn how to use various Workspace tools to 
create images and movies. 
 
 

Objectives 
 
After completing this module, participants will be able to: 
 

• Incorporate existing multimedia into a Workspace lesson 

• Create multimedia using Workspace tools 

 



________________________________

 

Add Existing Multimedia
 

Many instructors use various kinds of multimedia in their lessons including Flash objects, audio, 
and video. The Workspace software comes with multimedia files but gives you various tools to 
incorporate any existing resources you have into the Works
 
Interwrite Sims 
 
Multimedia resources available in the Gallery

simulations. They can be identified by the flash symbol 
the thumbnail image. Sims can be found in the Interwrite Sims 
within the Gallery. You can use your annotation tools with the Sims.
 

 
 
 
 
 
 
 
 
Flash Player  
 
Access your existing Flash files and put them on
 

1. Go to the toolbox  and select 
2. Browse to the file you want to use.
3. You can use your Workspace tools
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media 

Many instructors use various kinds of multimedia in their lessons including Flash objects, audio, 
and video. The Workspace software comes with multimedia files but gives you various tools to 
incorporate any existing resources you have into the Workspace environment. 

ultimedia resources available in the Gallery consist of Interwrite Sims, which are flash 

simulations. They can be identified by the flash symbol  in the lower right-hand corner of 
can be found in the Interwrite Sims category but are also embedded 
use your annotation tools with the Sims. 

                    

ccess your existing Flash files and put them on your Workspace page. 

and select Flash Player . 
you want to use. 

use your Workspace tools to make notes or annotate over your Flash entity.

Flash symbol 
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Many instructors use various kinds of multimedia in their lessons including Flash objects, audio, 
and video. The Workspace software comes with multimedia files but gives you various tools to 

, which are flash 

hand corner of 
t are also embedded 

to make notes or annotate over your Flash entity. 
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Audio Player  
 
Access your existing audio files and put them on your Workspace page.  
 

1. Go to the toolbox  and select Audio File .  
2. Browse to the file you want to use. 
3. When you are ready to play your sound file, press the play button. 
4. Use the pause and stop buttons as needed. 

 

 
 
Video File  
 

Access your existing video files (.wmv, .avi, .mpeg) and put them on your Workspace page. You 
can make annotations over your videos.  
 

1. Go to the toolbox  and select Video File .  
2. Browse to the file you want to use. 
3. Press play when you are ready to play your video. It will appear in the Workspace 

Media Player with its own annotation tools.  
4. When you select one of these special annotation tools, your video will automatically 

pause for you to make your notes on the video. 
5. To resume the video, click on the play button in the lower left-hand corner of the 

display window. 
 

 
 

Create Multimedia 
 
Although there are many resources available in Workspace, there may be times when you need 
to create your own customized content. There are several tools in Workspace to help you create 
images or videos. 
 
 
Create Images with Capture  
 
The capture tool allows you to selectively capture a portion of your screen. This can be from 
another application’s screen (i.e. Web page, PowerPoint, Word file, .pdf, etc.) or from a 
Workspace page. 
 

1. Access the media you wish to capture. 
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2. Click on the Capture  tool from the toolbar or toolbox. 
3. A window will appear asking which capture option you want to use: 
 

 
 

• Partial: Select a portion of the screen to 
capture. The output format will be in the form of 
a square or rectangle. A window tool will appear. Drag over the selection you wish to 
capture. 

 

• Freeform: Select a part of the screen to capture by drawing a freehand shape. A 
special pen tool will appear. Draw a freeform shape around the selection you wish to 
capture. 

 

• Window: Capture the active window opened. 
 

• Screen: Capture what is displayed on the entire screen. 
 

4. If you want your captured image to be placed into a blank Workspace page, make 
sure you check the box labeled Place capture in new page. 

 
 
Export Entities as Images  
 
This tool allows you to save your annotations as an image file. You can save your image to a 
location other than the Gallery with this option.   

1. Use the white Selection tool  to select the annotations you want to use to create 
an image.  

2. Choose the Export Entities   button from the Properties Bar at the bottom of 
your screen. 
 

3. Select the file type you want your image file to be, where you want your entity to be 
saved, and name the image file. 
 

4. Click on the Export Button. 



________________________________

 

Add Files to Gallery  
 
To add images you created to the Gallery, 
image to the Gallery. However, if you would l
steps: 
 

1. Use the white Selection tool
an image.  

2. Choose the Add files to Gallery
your screen. 

 
3. Choose whether you want to 

Gallery. 
 
4. When the item is added to the Gallery, a window will appear to confirm.  Click 

  

_________________________________________ Workspace Level 1 Training Workbook

 

created to the Gallery, use the Selection tool to drag and drop
However, if you would like to add annotations to the Gallery, follow these 

Selection tool  to select the annotations you want to use to create 

Add files to Gallery  button from the Properties Bar 

Choose whether you want to Add Selection to Gallery or Add Current Page to 

When the item is added to the Gallery, a window will appear to confirm.  Click 
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drag and drop the 
ike to add annotations to the Gallery, follow these 

to select the annotations you want to use to create 

 at the bottom of 

Add Current Page to 

When the item is added to the Gallery, a window will appear to confirm.  Click OK. 
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Module 5:  

Using Workspace with Other Applications 
 

 
 
 

Overview 
 
This session is designed for the beginner who would like to use existing content with the 
Interwrite Board and Pad. Participants will need general knowledge of basic Workspace 
annotation tools. In this module participants will learn how to create annotations on top of 
existing Office documents, use Office Mode to insert annotations into a Microsoft Office 
document, and use Workspace tools with 3rd party resources such as Web sites, .pdf files, and 
document cameras. 
 
 

Objectives 
 
After completing this module, participants will be able to: 
 

• Use Workspace with existing documents 

• Use Office Mode to insert annotations directly into a Microsoft Office document 



________________________________

 

Using Workspace with Existing Documents
 
Workspace is designed to be used
computer. Generally resources fall into three categories: hardware, sof
files. When you select one of the Workspace annotation tools, your screen is captured 
automatically, thus allowing you to make notes without mo
create hyperlinks on Workspace pages to other 
 
 
Create Hyperlinks 
 

The links tool allows you to add a hyperli
other Workspace files, Web pages, Office documents, sound, or video files.
 

 
 

1. Use the Gallery or Workspace

2. Use the Selection tool 
3. Click on the Links button in the 
4. Click on Add/Edit Link. 
5. Select the type of document you want to link to

Link type. 
 

 
6. Browse to the file you want to link
7. Your selection will now have a 

follow the link. 
 

 

Link 
Button 
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Using Workspace with Existing Documents 

to be used with existing resources that are accessible from your 
Generally resources fall into three categories: hardware, software programs, and 

When you select one of the Workspace annotation tools, your screen is captured 
automatically, thus allowing you to make notes without modifying the original file. 
create hyperlinks on Workspace pages to other files or resources that you would like to use.

allows you to add a hyperlink to your Workspace document. 
eb pages, Office documents, sound, or video files. 

 

or Workspace tools to create an image on the page. 

 to select the object from where you want to link.
button in the Properties Bar. 

 
Select the type of document you want to link to by clicking on the drop down menu by 

to the file you want to link to, click OK. 
Your selection will now have a link button attached to it. Just click on this 
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accessible from your 
tware programs, and 

When you select one of the Workspace annotation tools, your screen is captured 
ifying the original file. You can also 

or resources that you would like to use. 

nk to your Workspace document. You can link to: 

to link. 

by clicking on the drop down menu by 

 

Just click on this button to 


